
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Eye On The World 

 PHOTOGRAM 
 Monthly Newsletter of the Redlands Camera Club  

      December 2020 
 

                    Photogram Editor – Debra Dorothy 
               Deadline for entries is the 25th of every month 

 
Redlands Camera Club meets: 1st & 3rd Mondays, 7:00         

pm First Presbyterian Church - 100 Cajon St - Redlands, CA 

                        Guests are always welcome 

 
ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked the way 

you expected? The problem is probably a difference in how your computer and the club projector display colors 

and brightness. You can fix this by calibrating your computer the same way our club calibrates our projector – 

with the ColorMunki. Set up is simple and the calibration process only takes a few minutes. Contact Carl Detrow 

at csdetrow@verizon.net  to reserve the ColorMunki. 

 
__________________________________________________________________________________________ 

 
Want to learn more about your hobby?  

       Click the link below to go to B&H learning Video Site: 

Click HERE

mailto:csdetrow@verizon.net
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
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President’s Message – Russell Trozera 

 

My Christmas wish to all people, especially to the members of our 

club is, Peace on Earth Goodwill To Men, wishing all of you Happy 

Holidays, Season’s Greetings, Best Wishes and a Happy New year 

in 2021. May all of you be healthy and safe throughout the year. 

 

Program for December 7, 2020 

 

Members Night Celebrating the Holidays 

Russell Trozera is inviting you to a scheduled Zoom meeting.  

Topic: Redlands Camera Club Members Night Celebrating the Holidays  

“What kind of celebration?” Your choice. Which holiday? Your choice. 

Send us up to 3 of your favorite shots that express the joy of a holiday celebration, and we’ll 

show them in our Zoom meeting, Monday, December 7, 2020, at 6:30 PM. We don’t plan on 

a formal critique of the images, but members may comment on what they like about the 

image or what could be improved.  

 E-mail up to 3 entries between November 16 and November 30 to 

csdetrow@verizon.net. 

 Competition requirements apply: JPG images, maximum 3.5 MB, up to 4,000 pixels 

on the long side, up to 200 dpi, sRGB color space, title reflected in the file name.(This 

is different from what we announced in the November Photogram. We’ll take care of 

the sorting.) 

 In the e-mail spell out the title and indicate whether critique is OK. If you don’t 

specify, we will assume that you will welcome comments. 

Time: Dec 7, 2020 06:30 PM Pacific Time (US and Canada) 

Join Zoom Meeting 

https://us02web.zoom.us/j/85101211259?pwd=SXRwMDJEZVlXVFJ3YzR2M3NyNndjZz09 

 

Thanks Everyone, 

 

Russell Trozera 
 

 

 
 
 
 

Photo by Russell Trozera 

 
 

mailto:csdetrow@verizon.net
https://us02web.zoom.us/j/85101211259?pwd=SXRwMDJEZVlXVFJ3YzR2M3NyNndjZz09
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Program for December 21, 2020 

 “Merry Christmas & Happy Holidays Zoom Social for those who would just like to visit 

Russell Trozera is inviting you to a scheduled Zoom meeting.  

Topic: Redlands Camera Club Zoom Holiday Social 

Time: Dec. 21, 2020 06:30 PM Pacific Time (US and Canada) 

Join Zoom Meeting 

https://us02web.zoom.us/j/82373267162?pwd=UDlKMXhHSkR0emRBQUhEK3Z2NW1zZz09 

  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Photo by Judith 
Sparhawk 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

https://us02web.zoom.us/j/82373267162?pwd=UDlKMXhHSkR0emRBQUhEK3Z2NW1zZz09
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Mentoring Chair – Rick Strobaugh                                                                                                    
 

Benefits of a Circular Polarizer Filter 

 
One of the simple things that will help your outdoor photos look much 

better is a Circular Polarizer Filter. If you are shooting outdoors, this 

filter is almost as important as the camera itself. It attaches to the end 

of your lens. And, the affects cannot usually be duplicated or achieved 

in post processing. The main purpose of this filter is to cut glare from 

your scene. Most of the time, the glare is very obvious, such as the sky 

being reflected off of water at a lake, stream or puddle. But it will also 

cut the glare off of building/car windows or other shiny objects like chrome. Another source 

of glare that most people don't think about is glare from vegetation or rocks in your scene. 

If the sun is shining on tree leaves, grass or brush, there will also be a slight amount of glare 

that is being reflected from the sky. 

 

I have demonstrated it many times to people by having them look through my viewfinder 

with the polarizer ring rotated to the point where it is not affecting the scene, I then rotate 

it while they are looking through it. When it peaks its affect, they often quickly look up 

from the viewfinder with surprised look on their faces. Sometimes, it is almost magic. The 

polarizer will enhance the rich colors, saturation and contrast of the scene. Especially, with 

the greens and yellows of grass and leaves. Fall colors and red rock formations of Sedona, 

suddenly pop with the colors. It will also darken the blues in the sky which makes any white 

clouds, pop out even more. It can make dark storm clouds even darker. I have had it affect 

the sky so much that the sky looks almost black. So, it can be overdone too. A thing to 

watch out for if shooting a horizontal, wide angle, part of your sky may be at the peak, 90 

degree angle and the other side at a much lower affect angle. That would result in darker 

sky on one side and much lighter sky on the other side. 

  

The power of the polarizer is most affective at a 90 degree angle from the sun. Shooting 

directly at or 180 degrees away from the sun, there is very little affect. But as you move 

your camera and lens towards 90 degrees, you will see it quickly take effect. Shooting a 

photo of the lake or stream with the glare on the water or wet rocks, you will suddenl y see 

the glare disappear and be able to see the rocks or logs under the water. The glare on the wet 

rocks along the shore of the stream will suddenly disappear completely or at least be 

reduced. Fall colors suddenly pop, grass gets darker and red rock formations intensify their 

colors. On an overcast day, the filter is effective at most angles since the sun is not affecting 

it. 

 

Another affect of the polarizer filter is that it will slow your shutter speed down 

approximately one to one and a half stops since it is a dark filter. This helps though when 

shooting waterfalls or streams. The water will get more of the nice, lacy look to the white, 

moving water parts of the stream or waterfall with the slower shutter speed. 

 

When purchasing a Circular Polarizer, don't be cheap. They can be found for $20.-$30. In 

this case, you definitely get what you pay for. For a good Polarizer, expect to pay $75. to 

$85. You can pay much more if you want to get even better results and better quality filter. 

I have one for each of my different sized lenses. I always keep the filter on unless shooting 

night shots or want faster shutter operation because it can also protect my lens. Camera 

swings into a rock or something and breaks the filter, no big deal. If it breaks the glass on 

my lens, much bigger deal. 
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RCC Photo Blog – Stan Fry 

 
Redlands Camera Club Group Members Only 

Are you a member of the Redlands Camera Club? Come and join our new Members Only 
group where you can share images, tips, tricks, offer support or insights, ask questions and 
interact with other members without all the other distractions of an open group. Please read 
the rules and you must be a Redlands Camera Club member to join! 

We are up to 70 users and almost 1,100 images on the RCC Photo Blog.  

If you do not already have an account, send an e-mail to signup@rccphotoblog.com and we will get you set up. 

The blog is a great place to get input on your images. Other Members’ images can help you find some 

inspiration (and perhaps some motivation). 

We are working on the image color issue for some images.  When images are submitted they are resized to fit 

different screens.  In this process, they are desaturated a bit.  We don’t know the cause of the problem yet, but 

are working on a solution. 

 

I got tired of sifting through photography sites and blogs trying to find useful learning material.  In response, I 

created pbdigest.com – a curated (sort of) collection of photography articles from over 100 photography blogs.  

Given that this site helps me keep track of useful learning resources, I though club members may benefit too.  I  

would also be interested in any feedback you might have.  Thanks for taking a look and I hope the site is helpful 

to you. 

_________________________________________________________  

 

Photo by Dennis Taylor 
                                         
 

 

https://www.facebook.com/groups/2521924061368053/?__xts__%5B0%5D=68.ARCMAALkoRBiKV1gSiQlz6tIFwP9hhA0vDx7b_cNQPtCWsrnFMzm43yvMG4XGCLGF8UwN6ingQLl8pIRVLlFRKC-t81BV15gmBA8fWuptNsT85AI8BJu5BBvlHdKIOPq2ehadlUiqXAE25HwAqNDrKmKcreKuQkyCDhfU2Um_PIjoNfzm-yMmxlb27M_n1MbD0VOrODP5y4kS-ZhpNbY2LxPmu3_rYsXSOvN0WdeXQl7Q-2T7MzbQ_OLg2lLhCYKDuqHemuPluGDQDo-X5EDmnmwkePxpl6cQa4AZrRYCNuceCLnaXdyOfA-jhJQJgHljsQCnUyWfkuT29YQzMFPQQcc4w&__tn__=HH-R
http://www.pbdigest.com/
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Announcements 
 

New – Personal Lightroom Coaching with John Williams 
 

Contact John Williams for some over-the-shoulder coaching in photo editing, a great way to learn. Using 

your selected images, John will work with you at your level to improve your understanding of key tools and 

techniques to make the most of your photos. John is a regular contributor of articles on Lightroom and 

Photoshop to the RCC Photogram. Reach John at jhwr@earthlink.net or talk to him at our meetings.  

 

RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

 

Museum of Redlands 

This newly-established museum needs quality photography of items in its collection, and has asked RCC 

for support. This sounds like a win-win situation, both for the museum and for our members who want 

to develop skills in ―product‖ photography. I envision a workshop to teach the fundamentals, and one or 

more shooting sessions to get into creating great images for the museum’s use. If you’re interested in 

being part of this service to the community, or just want to find out more about the opportunity, shoot 

me an email: educationworkshopsrcc@gmail.com  Thanks, Frank 

____________________________________________________________________________________________________________ 

Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to use in 

their studies. If you have such equipment you’re willing to donate to a worthy cause, please contact RCC 

member Constance St Jean and let her know what you have. Contact her by email at 
constancestjean@gmail.com 

 
 
 
 
 

 
 
 
 
 
 
 

Photo by Debra Dorothy 

 
 
 
 
 
 
 
 
 
 
 

mailto:jhwr@earthlink.net
mailto:educationworkshopsrcc@gmail.com
mailto:constancestjean@gmail.com
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Fall 2020 2nd Place Awards 
 

 
 

Theme of the Month Photos 
 
 
 
 
 
 
 
Photo by Julie Bullock 
 
 
 
 
 

 
 
 
 
Photo by Wayne Purcell 
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Photo by Russell Trozera 

 
 
 
 
 
 

 
 
 
 
 
                                                                                              
                                                                               
         Photo by Dennis Taylor 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Photo by Debra Dorothy 
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Here’s What I Think!  

This article covers different Adobe Photoshop/Lightroomtips and techniques.  The views 

expressed in this article are those of the author and do not necessarily reflect the views 

of Redlands Camera Club. 

By John Williams 

Need help?  If you have any questions about processing an image using Adobe 

Lightroom or Photoshop, email me at jhwr@earthlink.net (for RCC members only) and 

I will try to assist you. 

PHOTOSHOP TIPS 

 Improved Select-Subject Tool (Photoshop (v.21.2.0): 

 The new Select-Subject Tool has been significantly improved which will allow you to probably 

ditch the Pen Tool. 

 To use this more versatility and superior Select-Subject Tool, do the following: 

1. Duplicate the Background Layer (Ctrl+J). 

2. Select the Quick Selection or Magic Wand Tool to launch the Select Subject button in the 

Options bar (see figure below).  

 

3. Depress the Select-Subject button and in a few moments a selection will be made of your 

subject. 

4. Then click on the Mask icon at the bottom of the Layers panel. 

5. Normally this new Tool will do a great 

job of selecting hair and hard-edge 

edges. 

 To change the Transparent background to 

a solid color background, do the 

following: 

1. Depress the Create new fill or 

adjustment Layer icon at the bottom 

of the Layers Panel. 

2. In the popup menu, select Solid Color.  

The Color Picker will launch.  Make 

sure the ―H‖ button is selected and 

then drag the Color Slider up/down to 

get in the ballpark of the color you 

want. 

3. To reduce the intensity of the solid color, move the Picket Color circular icon in the Color Field 

horizontally to the left.  

 Create a Spotlight Background over your Solid Color background: 

1. Select the Solid Color layer then depress the Create new fill or 

adjustment Layer icon at the bottom of the Layers Panel.  In the 

popup list select Gradient.  The Gradient layer will be placed 

above the Solid Color layer. 

2. The Gradient Fill dialog will launch.  In the Style field, select 

Radial (see figure to right). 

3. Choose a White to Transparent Gradient:  Click on the Gradient 

field (Gradient Fill dialog) to launch the Gradient Editor dialog.  Then choose the Black to 

Transparent gradient (Preset>Basics – top left red arrow in figure below).  To change the black 

gradient to white click on the left color stop (white square below gradient field – left bottom 

red arrow in figure below).  To change the transparency of the gradient, click on the Opacity 

mailto:jhwr@earthlink.net


~ 10 ~ 
 

Stop (bottom right arrow in figure below) and in the Opacity field set the Opacity to 0%.  Press 

the OK button to return to the Gradient Fill dialog. 

 

4. Place your cursor over the word Scale (Gradient Fill dialog).  The cursor will become a Scrubby 

slider (a hand icon with small arrows pointing to the left and right).  When the Scrubby Slider 

icon is visible, clicking and dragging left/right decreases/increases the value in the Scale field.  

Keep your eye on the Preview window and increase the white shading around the cutout to 

taste. 

 

 Close all tabs at once in Photoshop: 

 Hold the Shift key down and click one of the documents X's. 

 To close all open images regardless of whether you're viewing them as tabs or floating windows, 

go to File>Close All.  If asked if you want to save changes, 

Photoshop will give three options save them all (or not) without 

further prompts.  Be sure to select the Apply to All box. 

 The most useful Blending Modes: 

 Multiply:  This blend mode will hide white areas and blend with the Layer below.  For example, 

you have black text printed on a white background.  When you use this blend mode, the white 

background will disappear and the black text be shown over the Layer below. 

 Screen:  This blend mode is opposite of Multiply where white will be shown and black hidden.  For 

example, if you add a new Black Layer and select Lens Flare (Filter>Render>Lens Flare).  Then 

change the Blend Mode to Screen to hide the black background. 

 Difference:  Used to align 
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 Overlay:  This blend mode hides 50% gray.  Used when Dodge and Burning 

 Color: When you change a layer's blend mode to Color, only the color (that is, all of the hues and 

their saturation values) from the layer is blended in with the layer or layers below it. 

 Luminosity:  When I is used curves, I changed the blend mode to luminosity.  This way the color is 

not affected. 

 Soft light: Every color that is lighter than 50% grey will get lighter, and every color darker than 

50% grey will get darker. 

 Make Colors Pop Using Photoshop’s Black & White Adjustment Mode: 

 Click on the Create new fill or adjustment layer icon at the bottom of the 

Layer Panel and in the popup menu select Black & White.  At this point 

your image will turn into a Black & White photo. 

 Change the Layer Blend Mode to Luminosity.  The image will then return 

back to a color photo. 

 Then move the Black & White color sliders to brighten or darken a 

specific color (Reds, Yellows, Greens, Cyan’s, Blues, and Magentas). 

 Home Screen: 

 The Photoshop home screen provides access to recent files, links to 

resources, and convenient access to opening and creating new 

documents. 

 If you don’t want to see the Home Screen, you can disable this feature by 

choosing Edit>Preferences>General Tab and unchecking Auto show the 

Home Screen. Next time you launch Photoshop (or close all documents) you will no longer see 

the home screen 

Sharpening — Lightroom vs. Photoshop 

 Generally, you should sharpen your photos in Photoshop rather than Lightroom Class ic.  Photoshop 

gives you more control over sharpening settings. 

 In Photoshop you can select from several different sharpening tools or filters. Typically, you should 

use the Smart Sharpen filter, though in some cases you can use the Unsharp Mask filter.  To select a 

sharpening filter, go to the menu bar and select (Filter>Sharpen>Sharpen filter). 

 For digital sharing, the photo will appear to viewers in the same way it appears on your computer 

screen, so it is relatively easy to achieve good sharpening settings. 

 For printing, you need to anticipate what the final result will look like based on the behavior of the 

specific paper and ink being used for the print. It’s difficult, if not impossible to judge how much 

you should sharpen an image for print output.  Reducing the viewing size to 50% will allow you a 

way to view the final print output. 

 Three types of sharpening: 

1. Capture sharpening is usually applied during the RAW development process. This can either occur 

automatically in your camera, when it saves the image as a JPEG, or it can occur manually using 

your RAW software. 

2.Creative Sharpening is the sharpening you perform between capture and output sharpening, its 

most common used is to selectively sharpen regions of a photograph. 

3.Output Sharpening:  After capture and creative sharpening, an image should look nice and sharp 

on-screen. However, this usually isn't enough to produce a sharp print. Effective output 

sharpening often makes an on-screen image look harsh. Matte/canvas papers often require 

more aggressive sharpening than glossy paper because of ink absorption. 

LIGHTROOM TIPS 

 Major Differences between Lightroom Classic and Lightroom (cloud version): 

1. Lightroom Classic has seven modules (Library, Develop, Map, etc.) whereas Lightroom Cloud does 

not use modules.  The left side of Lightroom Cloud UI (User Interface) is similar to the Library 

module and the right-side panel is used to edit. 
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2. The keyboard shortcuts are different.  For example, when you depress the P key in LR Classic, the 

image is marked as a Pick.  In Lightroom Cloud the P key opens and closes the left Panel. 

3. In LR Classic, your images are in Folders.  If you want to group images together, you place them 

in Collections.  In Lightroom Cloud, your images are placed in the Cloud.  You can group them 

together in an Album and to group multiple Albums together, you do that in Folders.  

4. All images are placed in the Cloud in Lightroom Cloud; however, to place images in the Cloud in 

LR Classic, you must place the images first to a designated Collection and you must designate 

that Collection to sync with the Cloud. 

5. In LR Classic you Import your photos into the Lightroom catalog and to a specific location on a 

drive using the Import button.  Where as in Lightroom Cloud, you depress the plus (+) button to 

the left of MyPhotos (see figure below) and navigate to the location of your photo(s) in File 

Explorer.  The photos you select will be uploaded to Adobe Cloud and the photos will not be 

moved. 

 

6. Lightroom Cloud Edit Panel uses different terminology.  For example, the Color panel in 

Lightroom Cloud contains the HSL (Hue, Saturation, and Luminance) sliders. 

7. The Tools have different terminology.  For example, the Spot Removal Tool in Lightroom Classic is 

called the Healing Brush in Lightroom Cloud. 
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8. There are no Virtual Copies in Lightroom Cloud.  If you want to do two or more processes to the 

same photo, then you will need to do it to a copy. Multiple instances of the same image are 

called Versions. 

9. The Print Module and its features are missing from Lightroom Cloud. 

 Four Quick Ways to Straighten a Crooked Photo: 

 Crop Tool: 

1. Depress the Auto button (#1 in figure to the right).  This will 

rotate the photo and straighten the horizon.  There will be 

times when it will not straighten the horizon correctly. 

2. Depress the Straighten Tool (#2–Level icon in figure).  Then 

draw a line over the crocked horizon.  When you release 

the mouse button, Lightroom straightens the photo so the 

line you drew is perfectly horizontal or vertical. 

 Transform Panel:  Before doing the next two steps, be sure to 

enable lens correction in the Lens Correction panel. 

3. Depress the Level button (#3 in figure).  This is similar to 

depressing the Auto button. 

4. Move the Rotate slider (#4 in figure) to straighten the 

horizon.  When you rotate your image, white edges will 

normally appear.  To remove the white areas, check the 

Constrain Crop box. 

 

 

 

 

_________________________________________________ 

 

 
 
 
 
 
 

Photo by Julie Bullock 

 
 

 
 

 
 
 
 
 

Photo by Mary Ann Ponder 
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Photogram Editor – Debra Dorothy 

A Note from The Photogram Editor 
 

 

The theme for the January Photogram is “Sepia and Black & White”. 

 

 

 

Please send your images to me by Dec. 25
th
 to have one included in 

the January Photogram. 

                                

mailto:debbiedsd.dorothy@gmail.com 

 

 

 

  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 

 
 

 

Redlands Camera Club P.O. Box 7261 Redlands Ca 92375 

 

http://www.redlandscameraclub.org/ 

 

Officers (2020-2021) 

President: Russell Trozera – Vice President/Program’s: Dave Gardner – Secretary: Deborah 
Seibly – Treasurer: Rick Strobaugh – Past President: Dave Ficke 

 

Chairs (2020-2021) 

 

Competitions: Carl Detrow – Education/Workshops: Frank Peele – Facebook/Blog: Stan Fry – 
Field Trips: Pending – Historian: Bruce Bonnett – Hospitality/Events: Pending – Librarian: Michael 
Graves – Membership: Stephanie Billings – Mentor: Rick Strobaugh – Photogram: Debra Dorothy – 

Publicity: Stan Fry – S4C: Deborah Seibly – Color Munki: Carl Detrow – Webmaster: Wayne 
“Woody” Wood/Debra Dorothy – Welcome: Stephanie Billings 

 

mailto:debbiedsd.dorothy@gmail.com
http://www.redlandscameraclub.org/

